More About MS Word

t Learning in this chapter

# Entering, Selecting the Editing Text
# Moving, Copying and Deleting Text
# Using Undo and Redo commands

# Using Spelling, Grammar And Thesaurus g
Features

MS Word 2010 is a popular Word processing program of the MS Office suit. It has a
number of features that allow you to work with text and create impressive documents
and reports. Let usrecall some of its important features:

1.

)
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MS Word allows you to type and edit text. It also allows you to format the text to
makeitlook attractive and easy to read.

MS Word allows you to insert pictures, tables, and even hyperlinks into a
document.

MS Word lets you set Page Margins, Header & Footer, etc. for the text document.
MS Word allows you to check and correct the spelling and grammar related
errors.

The Mail Merge feature of MS Word allows you to merge a single text with many
addresses to create multiple copies of a letter addressed to different individuals.
The OLE (Object Linking and Embedding) feature of MS Word allows you to
insert a chart or slide created in other office applications into your Word
document.

Remember

®= A word processor is software that allows you to create, edit, format and print a text
document. Afile created in MS Word is called a document.
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Recalling the Word Window

You can start MS Word 2010 by typing '"Microsoft Word 2010' in the search box on the
Start screen and then pressing the Enter key. The Word window will open on your

computer's screen with components as shown below :

Quick Access toolbar Title bar Command button Help
File tabj ‘ l
. v G
Ribbon—— ! roup
Dialog box
launcher
Cursor— —
Vertical
scroll bar
Ruler ———
Document———
area
View
Status —— <
bar buttons
Components of the Word 2010 window
FAMOUS PERSONALITY

The first version of Microsoft Word was
developed by Charles Simonyi and
Richard Brodiein 1981.

Entering Text In a Document

In word, while typing, you will observe that “Word’, wraps the text automatically.

Wrapping the text means that if the text does' not fit in the current line then Word shifts

it to the next line by default.
Basic things to remember while typing in MS Word :

1. Donot press the Enter key to go to the next line. Type continuously and press the

Enter key only when you want to start anew paragraph.

2. Give one space between words. Give one space after every punctuation made,

like after a full stop (.) or comma (,) etc.
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3. Keep the Caps Lock key off. When you need to type a few letters in capital, use
the Shift key instead of the Caps Lock key.

4. Use the click of the mouse or arrows key from the keyboard to move the cursor
anywhere within the typed text to insert or delete something.

1{ Remember

= Keep saving what you type in MS Word by pressing the Ctrl + S keys. This will ensure
minimal loss of data in case of a sudden system failure.

Selecting the text

After typing the text in a document, you can work on that to do so, you should first
select the text. You can select a part of text or the whole text according to your need. You
can use both keyboard and mouse to select text. The selected text is displayed on the
screenin a highlighted bar.
To select a block of text, we can use the Selection Area, which is the blank area in the left
margin of the document. We can select the textin a variety of ways.

Text selection in MS word screen

Displaying the selection area



Selecting the Text Using Mouse
® To select a single word in a
document, double click on it.

m To select a sentence, hold
down the Ctrl key and click
anywhere in the sentence.

® To select a paragraph, place
the pointer anywhere in the
paragraph and triple click
the left mouse. Clicking the
mouse button thrice quickly
is called the triple click.

®m Click anywhere in the
selection area while holding
down the Ctrl key or triple
click in the selection area.

TIP! Toselect the entire text press the Ctrl + A keys from the keyboard.

Selecting the text using keyboard

Place the cursor before the first letter of the sentence or word. Hold down shift key and
press the right Arrow key | — | till the desired portion of text is selected.

Editing in MS Word

Editing means making corrections and changes to a document to make it error free and
easy to understand. Adding and deleting text, correcting spelling and grammatical
errors are some of the things that we commonly do while editing a document.
Inserting Textin a Document

Inserting text means to add text at any position in between an already typed text. The
steps toinsert text are as follows:

1. Position the cursor to the right of the character 2. Type out of the required text. As you type the
where you want to insert the text. text, the existing text shifts to the right.
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Performing Cut/Copy/Paste Operations
A Cutor Copy operationis always followed by a Paste Operation.

Moving Text using the Cut/Paste Operations
Moving a piece of text means to cut a piece of text from one location and paste it at
another location. The Cut and Paste operations are used for moving the text. The steps
todosoare:

1. Select the text tobe cut.

2. Click onthe Home tab.

3. Inthe Clipboard group, click on the Cutbutton.

4. Take the cursor toarequired position and click on the Paste button.

... The cut next will appear at the cursor's position.

To move select the text and use Cut/Paste commands

To get rid of the Pasting options box that appears on use of the Paste button, double
click anywhere on the empty document area.

TIP! Youcanusethe Ctrl + Xkeys to cut the text, the Ctrl + V keys to paste the next.

Copying Text using the Copy/Paste Operations

To copy a selected piece of text means to place a copy of it at another place while
keeping it also at its original place. The copy operation does not affect the original text
that remains at its position in the document. The steps to use the Copy/Paste options

are given below.
1. Select the required text. Then click on the Copy button in the Clipboard group of
the Home tab.
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2. Takethe cursor toa desired position and click on the Paste button.
3. The copied text will appear at the cursor's position.

Selected text Copied text
TIP! You can use the Ctrl + C keys to copy the text and the Ctrl + V to paste it at a required
position.
Deleting Text

We can delete text from a document simply by using the Delete and Backspace keys.
The stepstodosoare:
1. To delete a character, place the cursor to the left of that character and press the
Delete key. Or place the cursor to the right of the direction and press the
Backspace key.

2. Todelete aword, sentence, paragraph or the entire text in a document, first select
itand then press the Delete key.

|

Selected text Text gets deleted on pressing
the Delete key

... The appropriate text will get deleted.

Using the Undo and Redo Commands

Microsoft word keeps track of all the changes that we make in

document. We can easily undo any change and restore the
original text.

Icon-X-4
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The Undo option, is used for reversing the last action we performed in MS word. The
Redo option, on the other hand, helps us to repeat the action we have undone using the
Undo option.
1. Openanew blank document and type any two paragraphsinit.
2. Selectthe Ist paragraph and press the Delete key.
3. Click on the Undo button from the Quick Access toolbar.
...The last action (deleting the text) will get undone and the text will reappear at
the same position.
4. Now click on the Redo button.
...The action undone (deletion) will be performed again and the text will get
deleted.
5. Close the file by clicking on the Close button. Click No in the confirmation box to
indicate that you donot want to save the file.

TIP! You can use the Ctrl + Z for Undo and Ctrl + Y for Redo.

Checking Spelling and Grammar in the Document

While typing in MS Word we often see text having red and green wavy lines under it. A
red wavy line under it. Ared wavy line indicates a spelling error and a green wavy line
indicates a grammatical error. We can correct spelling and grammar related errors by
following these steps.
1. Bring the cursor to
the beginning of the
document.
2. Click on the Review
tab.
3. Click on the Spelling
& Grammar button.
... The Spelling and
Grammar dialog box
opens. Spelling and Grammar dialog box
4. Inthe top portion of the box there is a mis-spelt word in red colour. In the lower
portion there are various suggested correct words.
5. Select the correct word.
6. Click onthe Change button.
The mis-spelt word will be changed with the selected correct word. In the same way the
rest of the mis-spelt words of the document can be checked and corrected one by one.
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i{ Remember

= If you wrongly type a word but the result is not a wrong spelling (for ex 'to’ instead of
'too’ or 'from' instead of 'form"), the spelling checker does not show the red wavy line.

TIP! Youcanusethe F7 key to check spelling and grammar.
Using Thesaurus

Thesaurus helps to improve your vocabulary by providing a list of words with similar
meaning (Synonyms) and word with opposite meaning (antonyms) for any word. The
steps to use this features are as follows:

1. Select the word for which you want to find synonyms or antonyms.

2. Click onthe Review tab. Select the Thesaurus option in the Proofing group.

3. The Research task Pane opens, displaying the synonyms and antonyms.

4. Move the mouse pointer to the suitable word. Click on the dropdown button and

select the Insert option. The existing word will be replaced with the new one.

Hardware refers to the physical elements of a computer.
This is also sometime called the machinery or the
equipment of the computer. Examples of hardware in a
computer are the keyboard, the monitor, the mouse and the
processing unit.

Using the Find and Replace Feature

The Find and Replace feature of MS Word helps us to find a particular word in a
document and replace it with another word. The steps to use this feature are as follows:
1. Open the document.
2. Onthe Home tab, click on the Replace button in the Editing group.
... The Find and Replace dialog box opens.
3. IntheFind whatbox, type 'Inpet'
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4. Inthe Replace with box, type
'Input’.
5. Click on the Replace button
and then click on the Find
Next button to find the next
occurrence of the word'
Inpet'.
Or
To replace all the occurrences of the word 'Inpet' at one go, click on the Replace
Allbutton.

1. Ratna wants to make sure that she does not have any spelling errors in her essay
which she is writing in MS Word. What features of MS Word she should use?

2. Meena wants to replace the word find by found throughout her document. What
features of MS Word should she use?

vo
3: POINTS to Recall

)

® MSword is a popular word processor program of the MS - Office suite.

= Selecting text means highlighting the text. Text selection can be done using both the
mouse and keyboard.

® Editing means to do correction and modifications in a document to make it error free.

= Moving the text means to remove text from one location and put it somewhere else.
This is done using the Cut/Paste options.

= Copying the text means to make a copy of text and place it elsewhere. This is done
using the Copy and Paste options.

® The Undo option helps us to reverse the last action. The Repeat option repeats the
action undone using the Undo command.

= The spelling and grammar command button lets you check the spelling and grammar
of the text in your document.

= Using find and Replace feature you can find a particular text-string in your document
and replace it with another text string.
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=4 TERMS to Learn

® Editing : Making corrections to a piece of text or document.

® Moving : Removing a piece of text from one place and pasting it at some
other place.

® Copying : Copying a piece of text from one location and pasting it at
another location.

® Selection Area : Blank area in the left margin of a document.

® Clipboard : Reserved place that stores data temporarily.

(CHAPTER
Check-Up

A. Tick (V) the correct answer:

1. 'Shift'and arrow keys are used to text.
(a) Delete (b) Select (c) Copy

2. Grammatical errors are indicated with a wavy line.
(a) Blue (b) Green (c) Red

3. Which command can be used to repeat an action undone by the Undo command?
(a) Redo (b) Undo (c) Stat

4. Making duplicate copy of the text is called:
(a) Copying (b) Moving (c) Cutting
5. Shortcut key to select the entire document is.
(a) Crtl+A (b) Crtl+B (c) Crtl+C
B. Fillinthe blanks with the help of given hints:
HINTS : Editing Copy Word processing Doubleclick Paste Undo Remove

1. MSWordisa popular program.

2. The and commands are used to create duplicate copy of
selected text.

3. Moving text means to text from one location and place it at another
location.

4. When we make changes to a document it is called
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5. The option helps to reverse the last action.
6. Toselectasingle word on the word.

Write (T) for True and (F) for False statements:

Redo means to cancel a command given earlier.

To select a single line we need to triple click on it.

Word allows us to insert text within an already typed text.

The spelling & Grammar command button is situated under the Review tab.
Find the Replace buttons are situated in the Paragraph group of Home tab.
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Match the columns correctly :

1. Hometab (a) ReviewTab

2. Reviewtab (b) Editing group

3. Triple click (c) Spelling & Grammar
4. Cut/Paste (d) Selecting a paragraph
5. Thesaurus (e) Moving text

Read the clues and name the following:
This key combination helps you to cut a text.

iinl

This mouse action helps you to select a paragraph.

This key combination selects the entire text in a document.

This command helps you to reverse the last action.
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This is what making corrections to a document is called.

Very Short Answer Questions :

1. Where are Undo and Redo buttons located?

2. Name the shortcut key to check spelling and grammar.

Short Answer Questions:
1. Whatisediting?

2. Whatisthesaurus?

3. Whatis difference between copying text and moving text?

4. How willyou select a single word and a sentence using the Mouse click?
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l I want to check spellings of the words, I have typed.

I want to move a piece of text from beginning to the end in my document.

I want to change all occurrences of 'was' with 'is'in my document.

a I have just deleted a piece of text accidently; I want to get it back.
i I provide list of antonyms or synonyms of a selected word.

Practical 1 : Using the Find and Replace Feature.

1. Opena New Blank document and type a
riddle in it as shown.

2. Press Ctrl+ A to select the whole riddle.

3. Copy/Paste the riddle below its
existing position.

4. Change all the instances of the Four to
Seven in the pasted riddle using the
Find and Replace option.

5. Now try to find the answer of both
these riddles.



Practical 2: Typing and editing in MS world.

1.

Open a new bank document file. For this click on the File tab, select the New option and
then select the Blank document template in the backstage view and click on Create
button.

Type in the text as shown (do not type the line marked by the red circle).

Insert the line "Capacity to take large amount of work". After the fourth line of the text
as shown here.

Cut this line and place it at the end of the paragraph.

Select the entire paragraph by using triple click of the mouse and copy it to the
clipboard.

Paste the copied paragraph three times in the same document to make four paragraphs.

Now check the spelling of the whole document and remove any spelling errors if there
are any.

Save the document by any name as you like.





